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Troubleshooting the MWTM and the Network
This appendix provides this information for troubleshooting basic Cisco Mobile Wireless Transport
Manager (MWTM) network problems.
This appendix contains:
•

Clearing a Locked-Up MWTM Display, page D-1

•

Investigating Data Problems, page D-1

•

Understanding MWTM Client Start Error Messages, page D-2

•

Checking MWTM Server Start Processes, page D-3

•

Viewing the MWTM Troubleshooting Log, page D-3

•

Viewing MWTM Data on the Web, page D-4

•

Troubleshooting IOS Commands on the Web, page D-4

•

Viewing Detailed Troubleshooting Instructions for Events, page D-5

•

Diagnosing a Typical Network Problem, page D-5

Clearing a Locked-Up MWTM Display
In the MWTM, events might cause message popups to remain in the background of your display,
preventing you from interacting with other windows. If you suspect that your display has locked up,
perform these tasks:
•

Ensure that you are running the MWTM on a supported operating system. For details on supported
operating systems, see Chapter 1, “Preparing to Install the MWTM” in the Installation Guide for the
Cisco Mobile Wireless Transport Manager 6.1.1.

•

Minimize windows and look for an MWTM message popup in the background.

Investigating Data Problems
If you suspect that there are problems with the data that the MWTM is displaying, perform these tasks:
•

Enter equivalent show commands on the router. Is the data the same as that visible by the MWTM?

•

Send SNMP queries to the nodes. Do all queries complete?

The results of these tasks can help you distinguish between a router problem and an MWTM problem.
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Understanding MWTM Client Start Error Messages

Understanding MWTM Client Start Error Messages
If you encounter one of these errors upon starting the MWTM client, follow the subsequent procedures:
•

DataModelMediatorService: Could not find service in RMI registry or the RMI Registry may be
down.

•

DemandPollerManagerService: Could not find service in RMI registry or the RMI registry may be
down. Check the MWTM server and ensure that it is running.

Data Model Mediator Service Error
If you have received this message: “DataModelMediatorService: Could not find service in RMI registry
or the RMI Registry may be down” either you have specified an incorrect port number when installing
the MWTM, or the server or RMI registry is unavailable.
To correct this problem:
Step 1

Verify that you specified a correct port number.

Step 2

Enter the mwtm status command on the server to determine the status of all MWTM servers on the local
host.

Step 3

Enter the mwtm restart command to restart any servers that are not running.

Demand Poller Manager Service Error
If you have received this message: “DemandPollerManagerService: Could not find service in RMI
registry or the RMI registry may be down. Check the MWTM server and ensure that it is running” one
or more of the MWTM server processes may not have started.
To diagnose and correct this problem:
Step 1

Enter the mwtm status command on the server to determine the status of all MWTM processes.
Check the output to see if the sgmDataServer and sgmTrapReceiver processes are in the “Not Running”
state as shown in the following example:
MWTM Web
Server IS Running.
Version Control System IS Initialized....
MWTM App
Server IS Running.
-- MWTM Database
Server IS Running.
-- MWTM Naming
Server IS Running.
-- MWTM MessageLog
Server IS Running.
-- MWTM DataServer
Server NOT Running.
-- MWTM Provision
Server IS Running.
-- MWTM TrapReceiver Server NOT Running.
-- MWTM TerminalProxy Server IS Running.
-- MWTM JSP
Server IS Running.

Step 2

If the processes are not all in the “Is Running” state, search log file /opt/CSCOsgm/logs/messageLog.txt
for this error message:
A java.IO.EOFException was encountered against the persisted.server.data file.
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Step 3

Enter the mwtm cleandb command on the server, which will restore the persisted.server.data file to a
valid state. The output should now show all processes running as shown in the following example:
MWTM Web
Server IS Running.
Version Control System IS Initialized....
MWTM App
Server IS Running.
-- MWTM Database
Server IS Running.
-- MWTM Naming
Server IS Running.
-- MWTM MessageLog
Server IS Running.
-- MWTM DataServer
Server IS Running.
-- MWTM Provision
Server IS Running.
-- MWTM TrapReceiver Server IS Running.
-- MWTM TerminalProxy Server IS Running.
-- MWTM JSP
Server IS Running.

Step 4

Start the MWTM client, then re-discover the network (for details, see Discovering Your Network,
page 4-4.)

Checking MWTM Server Start Processes
When you run the mwtm start command, normal output appears:
PROCESS
sgmDataServer
sgmMsgLogServer
sgmTrapReceiver

STATE
Ready
Ready
Ready

PID

Last Message

2586
2551
2600

Running
Running
Running

If the sgmDataServer and sgmTrapReceiver process do not appear in the Ready state, see Demand Poller
Manager Service Error, page D-2 for details on fixing this issue.

Viewing the MWTM Troubleshooting Log
The MWTM stores troubleshooting information in the /opt/CSCOsgm/tmp/cisco_sgm_tshoot.log file on
the MWTM server. This log, which is updated each time the MWTM Server Troubleshooting page is
accessed or the mwtm tac command is run, contains information that might be requested by Cisco
customer support personnel.
To view the log from the command line:
Step 1

Log in as the root user, as described in Starting the MWTM Client, page 4-2, or as a superuser, as
described in Specifying a Super User (Server Only), page 2-17.

Step 2

Enter:
cd /opt/CSCOsgm/bin
./mwtm tac

This command might take a minute or more to complete. When it completes, the MWTM shows this
message and prompt:
Output is in /opt/CSCOsgm/tmp/cisco_sgm_tshoot.log
Would you like to view it? [y]
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Viewing MWTM Data on the Web

Step 3

Press Enter. The MWTM shows the contents of the /opt/CSCOsgm/tmp/cisco_sgm_tshoot.log file.

Viewing MWTM Data on the Web
The MWTM provides an enormous amount of web-based troubleshooting information. From the
MWTM web interface, you can access many web pages containing MWTM data, including server status,
network status, installation logs, message logs, product documentation, and other important
troubleshooting information about the MWTM. For full details, see Chapter 11, “Accessing Data from
the Web Interface.”

Troubleshooting IOS Commands on the Web
Note

If you have implemented MWTM User-Based Access, this option is available to users with
authentication level Network Operator (level 3) and higher.
You can perform troubleshooting on a node or an object in the node’s hierarchy by:
1.

Selecting an object in a view in the navigation tree

2.

Clicking the Troubleshooting tab in the right pane

Note

Tip

The Troubleshooting tab is not available for all objects in the navigation tree.

To save the output of all executed commands to a log file, see mwtm tshootlog, page B-87.
Before you can run commands and view output, credentials must be properly configured. You can
configure credentials using the CLI command (see mwtm addcreds, page B-6) or through the MWTM
client (see Configuring Login Credentials, page 3-20). If credentials are not configured, the message
“No credentials available. Add credentials and reload the page” appears in the output pane.
The right pane for the Troubleshooting table shows these fields and toolbar buttons for the chosen object:
Field or Toolbar Button

Description

Object Name
(in heading)

Name as discovered by the MWTM.

Server Name
(in heading)

Name of the MWTM server associated with the node.

Update Interval
(in heading)

Time between automatic updates for the page.

Last Update
(in heading)

Date and time the information on the page was last updated by the MWTM.
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Field or Toolbar Button

Description

Category

Related commands are grouped together in categories. Some categories are
provided by default and cannot be modified. Additional categories are
user-defined.

Command

List of commands or tasks associated with the chosen category. A chosen
command can be executed using the Execute Command button.

Execute
Command

Executes the chosen command only.

Execute
Category

Executes all commands in the chosen category.

Cancel
Execution

Stops any execution process.

Clear Output

Clears all output from the screen.

Output Pane

Pane at bottom where command output appears.

Related Topics
•

Configuring Login Credentials, page 3-20

•

Viewing Troubleshooting, page 8-40

•

mwtm addcreds, page B-6

•

mwtm tshootlog, page B-87

Viewing Detailed Troubleshooting Instructions for Events
The MWTM provides extensive type-specific help and troubleshooting instructions for events. To see
help and troubleshooting instructions for an event, right-click the event and select Help for Event.
You can also provide your own enterprise-specific instructions to operators in the event help. For more
information, see Changing the Way the MWTM Processes Events, page 9-25.

Diagnosing a Typical Network Problem
This section contains this content:
•

Diagnosing a Typical ITP Network Problem, page D-6

•

Diagnosing a Typical RAN-O Network Problem, page D-9

When you use the MWTM to diagnose a problem in a network, follow these basic steps:
Step 1

Monitor the network using the MWTM main window and the topology window. For example, an object
in the topology map that changes color from green to yellow or red indicates a problem in the network.

Step 2

Use MWTM windows, especially the Details window, to begin investigating the problem.

User Guide for the Cisco Mobile Wireless Transport Manager 6.1.1
OL-13314-01

D-5

Appendix D

Troubleshooting the MWTM and the Network

Diagnosing a Typical Network Problem

Step 3

As you identify the source of the problem, examine the messages logged by the MWTM for more
detailed information about the sequence of events that led to the problem.

Step 4

Connect (by using Telnet or SSH) to the problematic node, if necessary.

Diagnosing a Typical ITP Network Problem
This real-life example provides detailed information about using the MWTM to diagnose a problem in
an ITP network:
Step 1

A network operator (we’ll call him Joe) is using the MWTM to monitor an ITP network. Joe has
customized his view, limiting it to only those nodes for which he is responsible.
(For more information about customizing views, see Chapter 7, “Managing Views.”)

Step 2

In the topology map, Joe notices a signaling point that has changed color from green to yellow. Yellow
indicates a status of Warning, which means that one or more links or linksets associated with that
signaling point is in Unknown or Warning status and is not flagged as Ignored.
(For more information about signaling point status, see Viewing Details, page 8-9.)

Step 3

Joe single-clicks the signaling point in the topology map.
The MWTM highlights the signaling point in the topology map, and in the topology ASP/SP/view table,
in the left pane of the topology window. With the signaling point highlighted, Joe can easily see that the
name of the signaling point is sgm-7500j.
The MWTM also shows all associated linksets in the topology ASPA/linkset table.
Joe double-clicks the signaling point’s name in the topology ASP/SP/view table.
The MWTM redraws the topology map, centered on sgm-7500j, making it easier for Joe to see the
relevant portion of the map.
(For more information about the topology window and how to use it, see Chapter 10, “Viewing Network
Topology.”)

Step 4

Joe notices that one of sgm-7500j’s diamonds is red, indicating that the associated linkset is either
Unavailable or Unknown. Joe single-clicks the red diamond.
The MWTM highlights the linkset in the topology map and in the topology ASPA/linkset table. The table
entry indicates that the linkset is Unavailable.
(For more information about linkset status, see Viewing Details, page 8-9.)

Step 5

Joe right-clicks the linkset in the topology map and selects View > Details in the right-click menu.
The MWTM opens the Details window, showing detailed information for the linkset.
In the Details window, detailed information for the chosen linkset appears in the left column and for the
adjacent linkset in the right column
Immediately, Joe sees that the left column is populated with MWTM data, but the right column is not.
The problem is in the adjacent signaling point-to-primary signaling point linkset.
(For more information about linkset details, see Chapter 8, “Understanding Detailed Object Functions.”)

Step 6

Joe clicks on Linkset under Summary Lists to display the list of links associated with the linkset,
identified by their signaling link code IDs (SLCs). In this case, only one link is listed, SLC 0, and it is
red, meaning it has failed and no traffic is flowing on the link.
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Joe selects SLC 0, and the MWTM shows detailed information for the link in the left column. Normally
the MWTM also shows detailed information for links associated with the adjacent linkset in the right
column, but in this case, that column is blank.
(For more information about linkset status, see Viewing Details, page 8-9.)
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Step 7

Joe decides to investigate the adjacent signaling point, so he double-clicks the adjacent signaling point
in the topology map.
The resulting display shows that the adjacent signaling point, sgm-2600a, is Unmanaged.
(For more information about signaling point details, see Chapter 8, “Understanding Detailed Object
Functions.”)

Step 8

Joe closes the Details window and returns to the topology window. He tries to find sgm-2600a in the
topology map, but the map is too complex. So Joe lets the MWTM find the signaling point or application
server process for him:
a.

He selects Edit > Find in the MWTM main menu. The Find dialog box appears.

b.

He enters sgm-2600a in the Search string field and makes sure the Name, check box is checked.

c.

He clicks OK to launch the search. Almost immediately, the MWTM finds the signaling point or
application server process and the Choose dialog box appears, listing all found objects.

d.

Joe selects sgm-2600a, and the MWTM automatically highlights sgm-2600a in the topology
ASP/SP/view table and in the topology map, and redraws the map centered on sgm-2600a.

(For more information about finding objects in the topology map, see Chapter 10, “Viewing Network
Topology.”)
Step 9

Joe wants to see recent events for sgm-2600a, so he clicks the signaling point in the topology map and
selects View > Events in the MWTM main menu. The Recent Events tab appears for the chosen object,
in this case showing recent events for sgm-2600a.
(For more information about viewing events, see Chapter 9, “Managing Alarms and Events.”)

Step 10

Joe decides to see if the MWTM can manage the signaling point. He right-clicks sgm-2600a in the
topology map and selects Manage in the right-click menu.
The MWTM changes the status of the signaling point from Unmanaged (red) to Warning (yellow), which
means the signaling point is active, but one or more associated linksets or links has a status of Failed,
Unavailable, Unknown, or Warning and is not flagged as Ignored.
(For more information, see Unmanaging and Managing Nodes or ITP Signaling Points, page 6-42.)

Step 11

Joe wants to see status change messages for sgm-2600a, so he right-clicks the signaling point again and
selects Event History > Status Change Messages in the right-click menu. The MWTM shows recent
status change messages for the signaling point in a web browser.
Joe sees that many of the links and linksets associated with sgm-2600a have a status of Unknown.
(For more information about displaying messages on the web, see Chapter 11, “Accessing Data from the
Web Interface.”)

Step 12

At this point, Joe must determine why so many of the links and linksets are Unknown. He must verify
that the MWTM server can ping the node (see Enabling the Terminal Server Proxy Service, page 3-11),
and that the MWTM is configured with the correct SNMP community name for the node (see Launching
the Discovery Dialog, page 4-6).
(For a list of some other actions Joe can take, see Verifying Discovery, page 4-14.)

Step 13

Finally, Joe can use another product, such as CiscoView, to further investigate the problem.
(For more information about integrating the MWTM with CiscoView and other products, see Integrating
the MWTM with Other Products, page 5-35.)
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Diagnosing a Typical RAN-O Network Problem
This real-life example provides detailed information about using the MWTM to diagnose a problem in
a RAN-O network:
Step 1

A network operator (we’ll call him Joe) is using the MWTM to monitor a RAN-O network. Joe has
customized his view, limiting it to only those nodes for which he is responsible.
(For more information about customizing views, see Chapter 7, “Managing Views.”)

Step 2

In the topology map, Joe notices a node that has changed color from green to yellow. Yellow indicates a
status of Warning, which means that one or more interfaces associated with that node is in Unknown or
Warning status and is not flagged as Ignored.
(For more information about node status, see the “Viewing Details” section on page 8-9.)

Step 3

Joe single-clicks the node in the topology map.
The MWTM highlights the node in the topology map and in the topology view table in the left pane of
the topology window. With the node highlighted, Joe can easily see that the name of the node is
MWR-1941a.
The MWTM also shows all associated interfaces in the topology Connections table.
Joe clicks the node's name and the zoom button in the topology view table.
The MWTM redraws the topology map, centered on MWR-1941a, making it easier for Joe to see the
relevant portion of the map.
(For more information about the topology window and how to use it, see Chapter 10, “Viewing Network
Topology.”)

Step 4

Joe notices that one of MWR-1941a’s diamonds is red, indicating that the associated interface is either
Unavailable or Unknown. Joe single-clicks the red diamond.
The MWTM highlights the connection in the topology map and in the topology Connections table. The
table entry indicates that the connection is Unavailable.

Step 5

Joe right-clicks the connection in the topology map and selects View > Configuration Details in the
right-click menu.
The MWTM opens the Details window (in the main MWTM window), showing detailed information for
the connection. In the Details window, detailed information for the chosen connection appears in the
Configuration Data section.
Immediately, Joe sees that the Operational Status is Down but notices that the Operational Status for E1
1/0 is Up.

Step 6

Joe selects the Recent Events tab and notices that a Critical Alarm for E1 1/0 was recently added.
Joe logs into the MWR-1941a node (right-click on node name and choose Node > Connect To) and runs
the show controller E1 1/0 command. He learns that the node recently loss physical connectivity.

Step 7

Joe goes to the router and discovers that the cable is physically damaged. He replaces the cable and
returns to the MWTM server.

Step 8

Joe views the MWTM main window and observes that the MWTM has already polled the node and
changed the state color from yellow to green.

Step 9

Joe looks at the MWTM topology window again and verifies the interface status has changed from
yellow to green.
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